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If it weren’t for the events 27 years ago, on August
25, 1991, we might all still be running Windows.
How’s that for a horrific thought? On that date, Linus
Torvalds released Linux to the world. Look around.
Witness how much Linux has grown since that initial
release.

Linux is everywhere. Android
phones and tablets can thank
Linux, since they run a version of
the Linux kernel. Automotive
electronics are using Linux. Many
TV and DVD/Blu-Ray players use
Linux for their user interfaces.
Ebook readers are mostly Linux
based. Linux serves as the
backbone for many IoT devices.
Linux runs the vast majority of
supercomputers around the world.

Linux is everywhere.

Without it, where would we be?
There aren’t a whole lot of other
choices. Besides Windows, would
we run Mac OS? Probably not, with
Apple’s closed ecosystem. We
could run one of the Unix based operating systems.
But Unix seems more divided than Linux. Or, would
something altogether different step up to fill the void
left by the absence of Linux?

I shudder at the thought.

Would Linux’s replacement be something we’ve
already seen? AmigaOS, maybe? OS/2? Or would it
be something none of us could imagine because it
doesn’t even exist? Would it embrace open source
software as we’ve come to know it?

Linux is special in many ways, and not just because
we all (me and all you readers) use it day in and day
out. Linux users are special, and are not just your
average computer user. Everyone and anyone who
desires to do so can view and study the source
code. Users can alter that source code pretty much

as they see fit. Users can
contribute code to customize,
improve and extend Linux.

After years of literally and totally
being ignored, computer hardware
manufacturers are now supporting
Linux with device drivers to make
that hardware work/run under
Linux. I’ve noticed a HUGE
difference since I first started using
Linux regularly about a dozen
years ago. Back then, there were
a lot of homegrown, roll-your-own
device drivers by the Linux
community. Very few hardware
vendors thought that the “Linux
market” was big enough to warrant
the time, energy and effort put into
development of device drivers for
our beloved operating system.

Thankfully, Linux gained a market share that, by
some estimates, exceeds that of the Mac OS. All of
a sudden, and thankfully, the hardware vendors saw
Linux users as too large of a market to ignore.
Within a one or two year period, we saw tons of
hardware vendors jumping on the Linux bandwagon,
offering up driver support for their products.

Boy, how things have changed. Every major wireless
chipset is backed by drivers from their vendors. Go
out and look at printers. Virtually every big name
printer manufacturer not only offers drivers for Linux,

but they prominently and proudly display that
support either on the box that the printer comes in,
or in the device specifications for the printer. Down
the line of computer accessories and hardware,
Linux support has blossomed and proliferated.

No longer does Linux languish in obscurity. Ten
years ago, it was rare for me to find anyone who
knew of – or even heard of – Linux. Today, I find a lot
of people who at least know what I’m talking about,
even if they are not users themselves. With virtually
no advertising budget, there are quite a few factors
the helped to pull Linux out of the shadows.
Certainly, the increased market share led to much
more of an increase by word-of-mouth. Support from
hardware manufacturers certainly has helped, but
with that one, it’s kind of like the debate about which
came first, the chicken or the egg. Did the growth of
the Linux market spur the support, or did the support
help spur the growth? Certainly, Microsoft putting out
a flop version of Windows every other release cycle,
something they have a long, long history of doing,
helped drive new users to Linux. With every flop
version of Windows released, the Linux community
seems to see a new flood of refugees, many of
whom never realized that there was an alternative.

So, Happy Birthday, Linux! You’ve come a long way,
baby! Your future is bright for continued growth.

Until next month, I bid you peace, happiness,
serenity and prosperity.

DOWNLOAD

Mate Desktop

From The Chief Editor's Desk ...
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by Meemaw

I found this tutorial in the same place as the grass
tutorial we did a couple of months ago. This is to
make a tree easily, rather than trying to draw one by
hand.

Open Inkscape and click on Extensions > Render >
Random Tree. You’ll see a dialog box like the one
below.

There are only two settings: Initial size and
Minimum size. Set those to 100 and 4 respectively.
Check the Live preview box and look at what you
get. You can try again by unchecking the Live
preview box and rechecking it (bottom, left).

I decided on this one:

Open up the Fill & Stroke dialog and change the
Stroke to a color green with a width of about 40px.
Set the Join to Miter so it’s still jagged, like trees
are.

Select your tree and click on Path > Stroke to Path.
This will convert your tree into a much more simple
shape, because we’re going to change it.

We’re going to deal with the leaves and the trunk
separately so, using the Pen tool, draw a shape
around the trunk.

Select both the tree and the shape you just drew
and use Path > Division. You should get something
that looks like the tree below. Change the trunk to a
brown color of your choice.

Inkscape Tutorial: Drawing A Tree
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Now, with the cut we just made, our leaves look way
too straight on the bottom. To fix this, copy and paste
the leaf bunch and then flip it vertically.

Now place the two leaf sections together, one on top
of the other. You can then group them, or you can
select both leaf objects and do a Path > Union to
merge them. I also lengthened the trunk as well. It’s
your creation, so it’s up to you.

Now, to make it more realistic, copy the entire tree
top and flip it horizontally and give it a slightly darker
green color. You can also rotate it and/or change the
size. Send it to the bottom of your drawing to give it
some depth.

Now we also want to add a shadow to the tree trunk.
Copy the tree top and tree trunk. Give the tree top
copy a black fill with a 50% opacity. Leave the tree
trunk in position as we’ll be clipping it for a proper
shadow.

Move the tree trunk on top of the shadow, select
them both, and click on Object > Clip > Set. What
you will end with is a shadow of the tree top on the
trunk (right, top).

Click on your tree top and bring it back to the front. I
also moved the trunk down just a little, and
shortened up the tree top so the shadow is visible
(right).

To add some finishing touches, I grouped all the tree
pieces, duplicated the tree, changed the size of the
duplicate and flipped it horizontally. Then I moved it
elsewhere on the page. In addition, I put in some sky
and some of the grass we made a couple of months
ago (next page, top left).

Inkscape Tutorial: Drawing A Tree

https://pclosmag.com/html/Issues/201806/page03.html
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The last step is to export the drawing in the format of
your choice.

I’m sure your creation is wonderful! I hope you had
fun with this!

Screenshot ShowcaseScreenshot Showcase

The PCLinuxOS Magazine

Created with Scribus

Posted by Mr Cranky Pants-YouCanToo, July 1, 2018, running KDE.

Inkscape Tutorial: Drawing A Tree

http://pclostalk.pclosusers.com
http://www.scribus.net
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by Paul Arnote (parnote)

Background

I can remember back in 2004, when Gmail first
launched publicly. Some thought it was an April
Fool’s joke, since the public release date was April 1,
2004. Back then, it was in beta and only available by
invitation (it was, in fact, considered “beta” until
2009). I remember asking everyone I knew if they
had a Gmail account, and if they did, to please send
me an invitation. Users could each send out either
50 or 100 invitations (I forget the actual number) to
friends and family (initially, it was three invitations,
and then increased to six, before the loftier 50 or
100 invitations). It took me a few months to finally
get my invitation, since some people I knew weren’t
freely handing out their “allotment” of invitations. In
fact, some users were “selling” Gmail invitations on
Ebay for as much as $150 (U.S.). The selling of
Gmail invitations is what prompted Google to
increase the number of invitations to the much

higher number of 50 or 100, blowing out that
“market.”

Gmail’s chief architect was Paul Buchheit, the 23rd
employee of Google. He started working on Gmail in
2001 in an almost Skunkworks fashion. Gmail was
kept hidden from all but a few select Google
engineers. By 2004, virtually all Google employees
were using Gmail for internal email communication.
In addition to Gmail, Buchheit also developed the
original prototype for Google AdSense, as well as
suggesting Google’s former company motto of “Don’t
be evil” back in 2000 at a meeting to discuss
company values. Buchheit left Google in 2006.

Gmail was a bit different back then. Almost no one
back then worried about whether “Big Brother”
Google (or anyone else) was reading their emails.
One early feature (that started showing up as early
as 2006) was a configurable “news feed” bar at the
top of the Gmail inbox mail list window that users
could customize with RSS news feeds that appealed
to their interests. Sadly, that feature is one of many
that have been lost through the years and many
Google redesigns of Gmail.

You’ll notice that the early Gmail did not include a
contacts manager. The earliest reference I can find
for Gmail having a contacts manager is 2006.

How Gmail looked in 2004.

Knew It All Along: Your Gmail Is Being Spied Upon

https://en.wikipedia.org/wiki/Gmail
https://en.wikipedia.org/wiki/Paul_Buchheit
https://en.wikipedia.org/wiki/History_of_Gmail
https://en.wikipedia.org/wiki/AdSense
https://en.wikipedia.org/wiki/Don%27t_be_evil
https://en.wikipedia.org/wiki/Don%27t_be_evil
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Don’t be fooled. Google makes money from Gmail
by targeting ads to its users. That’s one of the
reasons Buchheit helped lay the foundation for
Google AdSense, so he could help monetize Gmail
for its public release. Today, those ads occupy the
space formerly occupied by the RSS news feed
ticker (unless you use an ad blocker, like UBlock
Origin or AdBlock Plus).

As of April, 2018, Gmail is offered in 72 languages
around the world, and boasts 1.4 BILLION users
worldwide (yours truly, included).

Where The Doubts Start

Once Gmail started targeting ads to users in
earnest, the questions started. It turns out that
Google was electronically scanning users emails
using an algorithm to discover the interests of
individual Gmail users. Google has claimed all along
that a) no human eyes at Google ever see your
email, and b) things like medical conditions, sexual
orientation, race, creed, religion or any other
potentially discriminatory data were never used. But,
by scanning the email of Gmail users, the ads
appearing in Google AdSense would be targeted to
that specific user’s interests, as indicated by the
content of their emails.

Understandably, this literally freaked out a lot of
users. Trust in Google plummeted (even more),
since despite Google’s admission that no human
eyes have ever or would ever routinely read any
user’s emails, doubts remained in a good number of
users minds. Tons of questions and red flags
remained, such as: Google can keep unlimited
amounts of information on a user forever, that
information could be used to build profiles of
individual users, emails sent by users of other email
services get scanned without the sender ever having
agreed to Google’s privacy policy or terms of
service, Google’s ability to change its privacy policy
unilaterally, and they can make minor changes
without ever notifying the end user.

Granted, there are a whole slew of people who really
couldn’t give two nickels about their privacy. But
then, there are a whole lot of people who are
legitimately concerned about their privacy, and work
hard to protect it. I have to admit that I’ve seen a lot
more people concerned about their privacy in the
Linux community than I ever saw in the Windows
world. But then too, I’ve not spent any significant
time in the Windows world for much of the past
decade that I’ve been running Linux.

Google ceased the scanning of the emails of Gmail
users in 2017. Instead, they collect their user data
from individual user’s use of Google’s other
services.

The Current Dilemma

While Google itself has stopped scanning the emails
of Google users, there are a lot of third party apps
that still do. This revelation was revealed in a July 2,
2018 Wall Street Journal article (subscription
required). Of course, the news spread quickly, and

far and wide. Hardly a news outlet spared any time
at all getting word out to users. In some cases, it
was reported that users intimate and private emails
were being read by another human.

Several news outlets immediately posted information
on how to limit the damage by monitoring which
apps have access to your Google accounts, and
how to rescind any access to apps that you may
have previously given permission to. Even Google,
in their response to the news on their blog without
directly addressing the WSJ article, directed users
on how to limit the damage.

Basically, travel over to your Google accounts page,
and select “Apps with account access” from the
menu on the left side of the screen. From there, you
can change access permissions for any app listed.

While any platform that can access Gmail is at risk,
the risk seems to be much higher for Android users.
Pay particular attention to the specific access
permissions for any and all apps you install. I use an
Android phone and tablet, and I’m always

Knew It All Along: Your Gmail Is Being Spied Upon

https://github.com/gorhill/uBlock#ublock-origin
https://github.com/gorhill/uBlock#ublock-origin
https://adblockplus.org/
https://en.wikipedia.org/wiki/Gmail#Automated_scanning_of_email_content
https://www.wsj.com/articles/techs-dirty-secret-the-app-developers-sifting-through-your-gmail-1530544442
https://www.cbc.ca/news/business/gmail-privacy-security-1.4733533
https://www.blog.google/technology/safety-security/ensuring-your-security-and-privacy-within-gmail/
https://myaccount.google.com/
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scrutinizing the permissions and access that apps
are asking for, both when they are installed and
when they are updated. If an app asks for
permissions I’m not willing to provide, that app
doesn’t get updated or installed. Instead, it gets
deleted from my phone or tablet. There’s no reason
for a game (trust me … I don’t have many, and none
that anyone would consider popular, like Candy
Crush) to have access to my photo storage, my
email, my contacts, or any other personal and
private data that might be on my phone or tablet.

Google claims to vet the third party app developers
rigorously and thoroughly to insure that only the data
necessary to achieve the third party app’s goals is
accessed. As an Android user, I have to say that
doesn’t seem to be the case, judging by some of the
dubious permissions that are requested when I
install an app through the Google Play store. Given
the volume of apps in the Google Play store, there
doesn’t seem to be any good, surefire way to police
all those apps to make sure they are playing by the
rules.

So why would these third party apps need access to
your email? To quote the Business Insider article on
this issue:

Google has long allowed software developers the ability
to access users' accounts as long as users gave them
permission. That ability was designed to allow developers
to create apps that consumers could use to add events to
their Google Calendars or to send messages from their
Gmail accounts.

But marketing companies have created apps that take
advantage of that access to get insights into consumers'
behavior, according to the report. The apps offer things
such as price-comparison services or travel-itinerary
planning, but the language in their service agreements
allows them to view users' email as well. In fact, it's
become a "common practice" for marketing companies to
scan consumers' email, The Journal reported.

It isn't clear how carefully Google is monitoring such
uses. Many consumers may not be aware that they've
given apps such access to their accounts.

Summary

I don’t know about you, but I prefer to keep nosy
apps out of my calendar and email accounts. I’d
rather make my own entries and send my own

emails, thank you very much. In fact, I’d rather keep
as many eyes out of all of my accounts as is
humanly possible. It is MY data, and no one else has
any rights to it.

Remember, your private and personal information IS
the currency d’jour. It is up to you to keep it secure,
and to limit who has access to it. Even then, it
should only be limited access, limited by only what is
necessary to complete the task at hand.

Screenshot ShowcaseScreenshot Showcase

Posted by luikki, July 14, 2018, running KDE.

Knew It All Along: Your Gmail Is Being Spied Upon

https://www.businessinsider.com/how-to-disconnect-third-party-apps-google-account-gmail-2018-7
https://www.businessinsider.com/google-allows-app-developers-to-read-peoples-gmails-report-2018-7
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In the summertime with nothing to do
Come to the forum meet the Linux crew

A place so fine when you got Linux on your mind
PCLOS nothing better you will ever find

In the forum you will always be at ease
In the sandbox post anything you please

A cool OS known for its simplicity
Boot PCLOS no duplicity

No need to be rich Tex makes you a deal
If you are poor give anything you feel

Go to Pay Pal send a dollar one hundred or a dime
What an OS they make it make it really really fine

In the forum it's always party time
Invite a friend come and unwind

Sing along with me do dah do dah de dah de do
We are happy do dah do dah de dah de do

ms_meme's Nook:
Summertime In The PCLOS Forum

MP3 OGG

http://pclosmag.com/html/Issues/201808/files/summertimeinthepclosforum.mp3
http://pclosmag.com/html/Issues/201808/files/summertimeinthepclosforum.ogg
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Ingredients

1 box Betty Crocker™ Suddenly Salad®
classic pasta salad mix

3 tablespoons water
2 tablespoons vegetable oil
1 teaspoon ground cumin
1 can (15 oz) black beans, drained, rinsed
1 can (15.25 oz) whole kernel corn, drained
4 cups torn romaine lettuce
1 container (12 oz) refrigerated guacamole dip
1 1/2 cups finely shredded Mexican 4-cheese

blend (6 oz)
3 plum (Roma) tomatoes, chopped
1 can (2 1/4 oz) sliced ripe olives, drained
3 cups nacho-flavored tortilla chips

Directions

1. Empty Pasta mix into 3-quart saucepan 2/3 full of
boiling water. Gently boil uncovered 12 minutes,
stirring occasionally.

2. Drain pasta; rinse with cold water. Shake to drain
well. In medium bowl, stir together seasoning mix,
oil, water and cumin. Stir in pasta, beans and corn.

3. In 4-quart glass salad bowl or 13x9-inch glass
baking dish, layer lettuce and pasta mixture. Spread

guacamole evenly over top. Sprinkle with cheese
and tomatoes; top with olives.

4. Just before serving, arrange chips around edge of
bowl. Serve immediately, or refrigerate.

Tips:

Purchase a bag of ready-to-eat torn romaine lettuce
to save time.

Make this salad up to 24 hours before serving.

PCLinuxOS Recipe Corner

Layered Mexican Party Salad

http://www.dosgamesarchive.com/
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by Paul Arnote (parnote)

Thirty-Five Organizations From Tech, Finance,
Energy, and Biotech Join The Linux Foundation
and Invest in Open Source Technology

The Linux Foundation, the nonprofit organization
enabling mass innovation through open source,
announced the addition of 32 Silver members and 3
Associate members. Linux Foundation members
help support development of the shared technology
resources, while accelerating their own innovation
through open source leadership and participation.
Linux Foundation member contributions help provide
the infrastructure and resources that enable the
world’s largest open collaboration communities.

“Without the support and resources of organizations
such as these new members, we would not be able
to help open source communities accelerate
innovation on such a huge scale,” said Jim Zemlin,
executive director, The Linux Foundation. “We
welcome all our new members and look forward to
collaborating with them further.”

In addition to joining the Foundation, many of the
new members have joined Linux Foundation
projects like Automotive Grade Linux, Cloud Native
Computing Foundation, LF Deep Learning, EdgeX
Foundry, Hyperledger, LF Networking, OpenHPC
and Open Mainframe Project. For a full list of
members, visit https://www.linuxfoundation.org/
membership/members/.

Linux Foundation Silver members are organizations
that contribute to or otherwise support open source
communities and projects. The new Linux
Foundation Silver members who joined in the month
of May are:

* Abalta Technologies is a leading provider of
technology and infotainment solutions for the global
connected car market.
* Airbiquity is a leader in vehicle telematics,
geofencing, and connected car systems, with more
than 7 million connected vehicles on the road.
* Beike Finance is the leading residential property
financial services provider in China.
* BGI Shenzhen Co., known as Beijing Genomics
Institute prior to 2008, is one of the world’s genome
sequencing centers, headquartered in Shenzhen.
* BlackRidge Technology develops, markets and
supports a family of products that provide a next
generation cyber security solution for protecting
enterprise networks and cloud services.
* Blockdaemon is a Nodes as a Service platform
that empowers businesses to simply and efficiently
manage blockchain applications.
* CircleCI is a continuous integration and
continuous delivery platform that helps teams work
smarter, faster.
* DiDi is the world’s leading one-stop mobile
transportation platform, offering a full range of app-
based mobility options for over 450 million users.
* eBaoTech International’s mission is “make
insurance easy” – pioneering the 3G insurance tech,
or Java based core insurance system, eBaoTech is
moving to the 4G insurance technology which is
cloud native and microservices based.
* Edgewise Networks is the industry’s first Zero
Trust platform for hybrid cloud security – stopping
attackers’ lateral movements and protecting
workloads by allowing only verified applications,
users, containers, and hosts to communicate.

* Elastisys provides products and services in the
realm of Kubernetes and automation – enabling
intelligent autopiloting for IT operations, increased
performance, and availability of applications, all
based on world renowned cloud research.
* EPAM Systems provider of digital platform
engineering and software development services.
* Evernym, Inc. develops software solutions that
leverage distributed ledger technology to provide
every individual, organization and connected device
with secure and irrevocable identity.
* Experian is a consumer credit reporting agency.
* Integrated Computer Solutions, Inc is a full-
service information technology and IT security
consulting and professional services firm.
* IOWNIT is a technology-driven investment platform
built for investors, entrepreneurs, and their trusted
advisors to invest, trade and raise capital in private
markets.
* Kakaopay is a mobile payment and digital wallet
service by Kakao based in South Korea that allows
users make mobile payments and online
transactions.
* Kyra Solutions Inc has emerged as one of the
leading information technology service providers in
the State of Florida.
* Neusoft Corporation provides innovative
information technology – enabled solutions and
services to meet the demands arising from social
transformation, to shape new life styles for
individuals and to create values for the society.
* NuCypher enables seamless and secure sharing
of sensitive data between organizations as well as
allows enterprises to securely use cloud service
providers.
* Octarine delivers total visibility, easy policy
management, and strong app security with seamless
integration with systems such as Kubernetes, Istio,
and Kafka to reduce security threats, obtain

Short Topix: Is Your Router At Risk?

http://www.linuxfoundation.org/
https://www.linuxfoundation.org/membership/members/
https://www.linuxfoundation.org/membership/members/
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compliance, and achieve simple, secure
multi/hybrid-cloud.
* Omnitude is a project to revolutionise connectivity
between blockchain technologies and enterprise
systems.
* Optherium Labs is a global research and
development organization building a new standard
and synergy of blockchain solutions using an open
source, collaborative software development
approach.
* Ping An Technology (Shenzhen) Co. Ltd is the
technology incubator for Ping An Group, with strong
research and development capabilities in cloud,
artificial intelligence, and big data technologies – is
headquartered in Shenzhen and has branches in
Beijing, Shanghai, Chengdu, and Nanjing.
* Pokitdok is a healthcare API platform that makes it
faster and easier for you to bring new healthcare
applications and services to market.
* Rocket Software helps companies around the
world solve their most challenging business
problems by helping them run their critical
infrastructure, business processes, and data.
* RTE (Reseau D Transport d’Electricite) is the
French electricity transmission system operator
responsible for operating, maintaining and
developing the high and extra high voltage network.
* Safewrd Ventures OU aims to enable and train
companies to use open source and cloud
technologies to release new software faster.
* Shenzhen Ultrachain Technologies is a leading
blockchain technology solutions provider.
* Sitech Electric Automobile Industrial Co., Ltd. is
a supplier of electric mobility products and services.
* Sprint Corporation is a communications company
offering a comprehensive range of wireless and
wireline communications products and services that
are designed to meet the needs of consumers,
businesses, government subscribers and resellers.
* Thinkarchitecture AG supports software
architects and developers in the critical phases of
their projects.

Associate members of The Linux Foundation include
of government agencies and not-for-profit

organizations that have demonstrated a commitment
to building, sustaining, and using open source
technologies. The following organizations are new
Linux Foundation Associate members:

* Budapest University of Technology &
Economics is the most significant University of
Technology in Hungary and is considered the world’s
oldest Institute of Technology which has university
rank and structure.

* MIT Connection Science is working to unlock
the trapped potential of the digital networks that
surround us — from social media, to civic
infrastructure systems, to enterprise databases that
house and protect personal information.

* The New Mexico Consortium (NMC) is a non-
profit corporation that was created in 2006 by the
University of New Mexico (UNM), New Mexico State
University (NMSU), and New Mexico Institute of
Mining and Technology (NM Tech) in partnership
with Los Alamos National Laboratory (LANL) to
advance statewide collaboration in science research
and promote collaboration.

With the support of its members, The Linux
Foundation hosts open source projects across
technologies including networking, security, cloud,
blockchain, and more. This collaborative
development model is helping technology advance
at a rapid pace in a way that benefits individuals and
organizations around the world. (Source)

Google Becomes Latest Platinum Member of
Linux Foundation

The Linux Foundation, the nonprofit organization
enabling mass innovation through open source,

announces Google has become a Platinum member
of the foundation. Google’s mission from its founding
has been to organize the world’s information and
make it universally accessible and useful. Google
was previously a Silver member of The Linux
Foundation. Sarah Novotny, the head of open
source strategy for Google Cloud Platform, will join
The Linux Foundation Board of Directors as
Google’s representative.

“Google is one of the biggest contributors to and
supporters of open source in the world, and we are
thrilled that they have decided to increase their
involvement in The Linux Foundation,” said Jim
Zemlin, executive director, The Linux Foundation.
“We are honored that Sarah Novotny, one of the
leading figures in the open source community, will
join our board – she will be a tremendous asset.”

“Open source is an essential part of Google’s
culture, and we’ve long recognized the potential of
open ecosystems to grow quickly, be more resilient
and adaptable in the face of change, and create
better software” said Sarah Novotny, head of open
source strategy, Google Cloud. “The Linux
Foundation is a fixture in the open source
community. By working closely with the organization,
we can better engage with the community-at-large
and continue to build a more inclusive ecosystem
where everyone can benefit.”

Google has been an active and committed
contributor to the open source community for many
years, releasing and contributing to more than
10,000 open source projects to date. Some of The
Linux Foundation open source communities Google
supports include Cloud Foundry, Node.js and the
Open API Initiative.

Google was also a founding member of the Cloud
Native Computing Foundation (CNCF), having
created and open sourced CNCF’s popular
Kubernetes container orchestration platform.
Hundreds of Google employees remain heavily
involved in the project today. Additionally, the
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company is a founding member of the Core
Infrastructure Initiative, which takes a proactive
approach to securing some of the more important
software technologies in the world, and the TODO
Group, which collaborates on practices, tools, and
other ways to run successful and effective open
source projects and programs. Moreover, Google
has been a leader in Software Defined Networking
and other open source networking projects.

Becoming a Platinum member – the highest level of
membership – of The Linux Foundation gives
Google access to the foundation’s extensive
knowledge and experience in open source
governance, legal and technical topics. As a
Platinum member, Google will also receive a seat on
The Linux Foundation Board of Directors.

Sarah Novotny, who will represent Google on The
Linux Foundation Board of Directors, also
participates on the Node.js Foundation board.
Novotny leads the open source strategy team for
Google Cloud. She has long been an open source
community champion in communities such as
NGINX and MySQL.

More than 800 organizations are members of The
Linux Foundation and the open source projects it
hosts. AT&T, Cisco, Fujitsu, Hitachi, Huawei, IBM,
Intel, Microsoft, NEC, Oracle, Qualcomm, Tencent,
Samsung and VMware are also Platinum members.
To learn more about Linux Foundation membership
or to join the organization, visit
https://www.linuxfoundation.org/membership/.
(Source)

Is Your Router At Risk?

Over 500,000 SOHO and home routers are at risk
from a sophisticated malware attack by Russian
state-sponsored hackers. The malware, which Cisco
Talos labs has dubbed “VPNFilter,” can steal
personal information, redirect web traffic, infect other
devices, and even “brick” infected devices to render
them useless, as reported on a Tom’s Guide article
on May 29, 2018.

Most of the affected routers are from ASUS,
Netgear, Linksys, D-Link, TP-Link and MicroTik,
among others. Netgear and MicroTik routers were
affected/attacked especially hard. Minimally,
users/owners of affected routers should reboot their
routers. But, that isn’t a guarantee that the malware
is gone. To be sure, users/owners of affected routers
should do a hard reset of their routers, back to
factory settings, and then set their networks up
again from scratch. A list of affected routers can be
found on the follow-up article on Tom’s Guide, on
July 2, 2018.

So, how do you know if your router is among those
unlucky enough to be infected with the VPNFilter
malware? Fortunately, Symantec (the same people
who make Norton Anti-Virus) has come up with a
check, of sorts. While not a complete or perfect
check for the VPNFilter malware, it checks for the
presence of the SSLer plugin, which knocks a
HTTPS website down to a less secure HTTP
website. Just log into
http://www.symantec.com/filtercheck/, click on the
“Agree To Terms” checkbox, and click on the green
button on the page. The test is quick, and the results
are displayed immediately.

I was fortunate – and relieved – that my AMPED
router was not infected.

I’ve said it here many times before: your personal
data and private information ARE the currency of the
21st Century. It is up to you to do your due diligence
to protect it, at all costs. The ramifications are huge
for those who don’t.

Is Your “Smart TV” Spying On You?

Most “Smart TV’s” on the market today use Samba
TV, technology that allows marketers to track what
you’re viewing, so that they may target you with ads
that coincide with your interests, and so that they
may make content suggestions, according to a
recent New York Times article. This technology,
along with competing technologies, is known
collectively as ACR (automatic content recognition).

There’s hardly a TV vendor that doesn’t use Samba
TV on their smart TVs. The list includes Sony, TCL,
Sharp, Magnavox, Toshiba, Sanyo, AOC, and
Philips, to name a few. But it doesn’t stop there. The
software can also tell what other devices are
connected to your home wifi network. The collected
data is then used to target “more relevant
advertising” to you, based on your viewing choices.
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When customers setup a new TV, they are prompted
to enable Samba Interactive TV, without being
informed on exactly how much data is being
collected, nor the nature of the information that is
being collected. As a result, more than 90% of
people blindly opted into the service.

Once enabled, it can track virtually everything that
appears on your TV screen, second by second. It
reads pixels to identify what shows and ads you are
watching, including those on pay services like HBO,
and even video games. Samba TV has even offered
advertisers the ability to tailor ads based on political
leanings (liberal or conservative) based on the
information collected about viewing habits.

The details of what people are opting into, of course,
are hidden in obscurity. Unless someone takes the
time to research the terms and conditions, as well as
read the privacy policy, by going online before
deciding to enable the feature, users basically have
no idea of what they are opting into. Most users, in
their zeal to get their fancy, new TV setup and
running, most likely just enable the feature and
move on.

Do you want to read even more scary information on
Samba TV? Well, the folks behind Samba TV have
made it extremely easy. Just go here. You should be
able to get a fairly good sense of what kinds of
information they are tracking – and just how
vulnerable you are.

If you’re concerned about your privacy (and who
shouldn’t/wouldn’t be in today’s world?), you may be
wondering how to turn off ACR. Fortunately,
Consumer Reports has an article on how to turn off
ACR on several of the “big brand” smart TVs on the
market. Even if the manufacturer of your smart TV
isn’t on this list, it may give you some ideas on
where you need to look to be able to turn this feature
off. The manufacturers don’t necessarily make it
easy to disable this feature.

So what if you have a smart TV and can’t find the
menu to disable ACR? Well, Lifehacker has an
article that suggests that you reset your TV settings
to the factory settings. When you do that, you will
have to setup your TV all over again. But this time
through, pay attention to each menu, and skip over
anything that might seem suspicious or shady.
Others, commenting on the Lifehacker article,
recommend that you just turn off your smart TV’s
network connection. One commenter even had an
awesome suggestion to use a Raspberry Pi with Pi
Hole to block all ads from your home network.

I do wonder how this situation will play out under the
GDPR, since users have to jump through some
extraordinary hoops just to find out exactly what they
are opting into. In the U.S., the smart TV companies
are “regulated” (a loose term, for sure) by the FTC
(Federal Trade Commission). The FTC seems to be
okay with the obscurity – both in users being
informed about what they are opting into, and in how
difficult some manufacturers make it to turn off once
enabled. Smart TV companies operate under a
whole separate set of rules than broadcasters and
cable TV companies, both of whom are regulated by
the FCC (Federal Communications Commission).
Broadcasters and cable TV companies have much
stricter rules about data collection from
viewers/users of their services.

Gartner Says Worldwide PC Shipments Grew For
the First Time in Six Years During the Second
Quarter of 2018

Steady Business Market Demand Drives PC
Sales

Worldwide PC shipments totaled 62.1 million units in
the second quarter of 2018, a 1.4 percent increase
from the second quarter of 2017, according to
preliminary results by Gartner, Inc. This is the first
quarter of year-over-year global PC shipment growth
since the first quarter of 2012.

All regions experienced some growth compared with
a year ago. While the results are a positive result for
the PC industry, Gartner analysts said this sign of
market stability is not enough to declare a PC
industry recovery just yet.

"PC shipment growth in the second quarter of 2018
was driven by demand in the business market,
which was offset by declining shipments in the
consumer segment," said Mikako Kitagawa, principal
analyst at Gartner. "In the consumer space, the
fundamental market structure, due to changes on
PC user behavior, still remains, and continues to
impact market growth. Consumers are using their
smartphones for even more daily tasks, such as
checking social media, calendaring, banking and
shopping, which is reducing the need for a
consumer PC.

"In the business segment, PC momentum will
weaken in two years when the replacement peak for
Windows 10 passes. PC vendors should look for
ways to maintain growth in the business market as
the Windows 10 upgrade cycle tails off."

With the completion of Lenovo's joint venture with
Fujitsu, three out of four PCs were shipped by the
top five PC vendors in the second quarter of 2018.
With the inclusion of Fujitsu’s PC shipments due to
the joint venture (a formation of Joint Venture with
Fujitsu), Lenovo was in a virtual tie with HP Inc. for
the top spot in the second quarter of 2018 based on
global PC shipments (see Table 1). All of the top five
PC vendors experienced an increase in worldwide
PC shipments in the quarter.
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HP Inc. had its third consecutive quarter of year-
over-year PC shipment growth. HP Inc. maintained
steady growth across all regions, except the U.S. In
the other regions, its shipment growth well exceeded
the regional averages. Lenovo experienced its
highest growth rate since the first quarter of 2015.

While Dell's competitors have shown PC shipment
declines periodically in the past two years, Dell's
shipments did not decline during this time because
of its strong focus on growth areas, especially in the
commercial segment, as well as cutting off
unprofitable businesses.
In the U.S. PC market, the industry returned to

growth after six consecutive quarters of shipment
declines. In the second quarter of 2018, U.S. PC
shipments totaled 14.5 million units, a 1.7 percent
increase from the same period last year (see Table
2). HP Inc. continued to be the market leader in the
U.S., but Dell closed the gap, as Dell's U.S. PC
shipments increased 7.2 percent.
"In the U.S., business PC demand was particularly
strong among the public sector as the second
quarter is typically PC buying season among
government and education buyers," Ms. Kitagawa
said. "Desk-based PC growth was attributed to
continued high usage of desk-based PCs in the U.S.
public sectors. Mobile PCs grew in the U.S., but

strong Chromebook demand in the education market
adversely affected PC growth. Overall,
Chromebooks grew 8 percent in the U.S., but
Chromebooks are not included in the PC market
statistics."

You can read the entire press release here.

GitHub Exodus Exaggerated?

When Microsoft bought GitHub, the open source
community sounded a bit like Chicken Little
proclaiming that the sky was falling. And, you could
hardly blame anyone for sounding the alarm, after all
the hatred open source projects endured at the
hands of Microsoft for years and years and years.
The open source community’s wary eye towards
Microsoft has been well earned by the software giant
over the years.

So, it’s no wonder that Microsoft’s purchase of
GitHub sounded off the alarm bells. When the sale
of GitHub to Microsoft was announced, many GitHub
repository owners started looking for a new “home”
to host their endeavors. Most went to GitHub
competitor GitLab (which has just moved to Google’s
cloud, so you decide which is worse).

Granted, the migration from GitHub peaked shortly
after the announcement when 20,000 projects per
hour were being moved, mostly to GitLab, during a
two week period. But after that, things seemed to go
back to normal. Currently, there are over 85,000,000
code repositories on GitHub, and only a miniscule
number of repositories “jumped ship.”
It would appear that most repository owners have

Preliminary Worldwide PC Vendor Unit Shipment Estimates for 2Q18 (Thousands of Units)

Notes: Data includes desk-based PCs, notebook PCs and ultramobile premiums (such as Microsoft Surface), but not
Chromebooks or iPads. All data is estimated based on a preliminary study. Final estimates will be subject to change. The
statistics are based on shipments selling into channels. Numbers may not add up to totals shown due to rounding.

*Lenovo's results include Fujitsu's units starting in 2Q18 to reflect the joint venture that closed in May 2018.

Source: Gartner (July 2018)
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decided to take a “wait and see” approach to
Microsoft’s purchase of GitHub. Plus, moving a
repository to another location might confuse users.

Screenshot ShowcaseScreenshot Showcase
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by Alessandro Ebersol (Agent Smith)

This is the final chapter of the YouTube series, the epilogue.

Over the past six months, we talked about various emulators, audio and video
programs that help in making videos for YouTube. Here is a recap, in the table
below, the list of programs that have been addressed, along with their usefulness.

Program Purpose
DOSBox Generates videos of DOS games and programs
OpenMSX MSX computers brand
Hatari Atari ST computers brand
Ep128Emu Spectrum and Armstrad computers brand
MAME Several Arcades
Audacity Audio Editor, normalizer, improve sounds
jPSXdec Extract movies and audio from PS1 games
Rezound Another audio editor, improves sound and

applies effects
Mednafen A dozen systems
Simple Screen Recorder Powerful screen capture software.

So examined all these programs that help in creating videos. However, some
rules must be followed for sending videos to YouTube, and obviously, to get their
monetization.

YouTube Rules

A special care should be taken with copyrighted material: Licensed music, other
video clips that have copyrighted material and the like. The rule of thumb here is:
Copyrighted music will always be demonetized. I will return to this subject soon.

Other details to watch out for on YouTube are nudity, profanity, and incitement to
racial, sexual or religious hatred.

In the case of copyrighted songs, the tip is to mute these songs when they
appear in the video. Otherwise, you lose the monetization of this video.

The so-called Fair Use is somewhat uncertain on YouTube, as there have been
several instances of parodies and other uses that would fall on Fair Use, yet the
videos have been removed. I'd say it's a very gray area of YouTube, and you can
not be sure of anything.

However, YouTube is no longer what it was once, and excessive copyright zeal,
censorship, and other new rules are hitting small content creators hard.

There is something rotten in YouTubeland ...

Well, as I mentioned above, copyright strikes are making it harder to work on
YouTube. As I mentioned Fair Use, there is no clear rule, and many materials that
would fall into this classification, either are removed or are demonetized. Now,
YouTube shoots first and asks questions later. First your video is either
demonetized or taken off line, and then the merit of the strike is judged. Plus, the
Content ID technology is abused by large companies. Even with YouTube
creating a "safety net" for creators, it just does not work for large companies, just
small copyright trolls. But it's not just that. These same companies, who claim
copyright infringement, use the same Content ID tool to silence bad reviews of
their products, or when YouTubers raise negative issues about those companies.

And, things get worse. Depending on the keywords in your video, YouTube will
not monetize your video either, thanks to an advertiser-friendly video policy,
which cuts video monetization with controversial keywords. It’s clearly done by
robots, but it blocks legitimate content, while allowing a lot of bad content to slip
through.

Copyright Abused ...

Copyright laws are completely obsolete and fundamentally broken. To get an
idea, let's take a video game (or it could be a movie, too), like the famous game
that came out on Playstation 1, Tony Hawk's Pro Skater. There are dozens of
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songs licensed in this game, such as: The Suicide Machines’ "New Girl",
Goldfinger’s "Superman", Speedealer’s "Screamer/Nothing to Me", Dead
Kennedys’ “Police Truck”, Primus’s "Jerry Was a Race Car Driver", among many
other famous songs, and the producer, Activision, paid the artists when the game
was made.

Now, if you make a video gameplay about this game, as the game is, with all its
soundtrack intact, YouTube Content ID will flag all the songs, and reverse the
monetization to the copyright holders of each one from them. That is, you had the
labor of making the game work, captured all the footage, edited the raw material
on a program of your own and even uploaded the video, and you will not get
anything for it. Meanwhile, the copyright holders will take all the monetization of
the video, no sweat nor anything, from all your work. And, the legit authors
receive part of that amount, but it depends on the company that manages the
rights. It is ridiculous to see how copyright maximalists struggle, to have their
rights extended eternally, and at the same time stop cultural evolution. After all,
everything that exists is a mashup of things that have already been around.

Copyright laws have to be reformed, because today, they serve more large
groups, and less the artists and authors, since their income is marginal, while
rights groups take the lion's share. But thanks to Disney, things will not change
anytime soon (for example, we will have wait for 2023, when Mickey enters into
the public domain).

But because of these YouTube policies, I do not make videos about this game
(Tony Hawk's Pro skater).

Logan Paul and the demonetization of the small channels

YouTube also struck a heavy blow to small creators in February 2018 with new
rules for monetization.

After a controversial video from YouTuber Logan Paul, YouTube changed
monetization rules. Starting February 20, 2018, only channels that have been
viewed for 4,000 hours and have 1,000 unique subscribers in the last 12 months
will be able to host ads and share revenue. This is being seen as a significant
improvement over the standards introduced last April, which required more
followers but did not set a standard for display time. But, anyways, YouTube is
penalizing the small creators of content, and favoring the big channels, which
have a much more expensive and professional production, production teams and
more people working on the videos. No more the solo guy making a video in his
room and sending it to YouTube, which is a sad reality, when YouTube tries to
suffocate those who have made it such a popular service. The order now is to

privilege content said "professional" and advertiser-friendly at the expense of
small channels. Sadly, this trend, which has been happening since 2012, and
culminated with the clueless videos of Logan Paul, had a hard impact, and was
called "adpocalypse."

The so-called Adpocalypse was so severe that it led to the famous shooting in
San Bruno, California at the headquarters of YouTube.

And, YouTube has launched its paid streaming service, YouTube Red, showing
more hints of the direction it is following now.

Censorship and Content Removal

Censorship and content removal also worsened recently, when YouTube began
censoring videos that it considers controversial, or, to please the government of
certain countries (China, Pakistan and others).

The Conclusion

As we've seen above, the picture for anyone trying to get into YouTube now is
quite disheartening. YouTube is closing the door to the little guys, while trying to
become a new Netflix.

Nothing against changing and expanding, but one must preserve its initial
audience. YouTube today tries, with all its forces, to become a vehicle of
communication as a new Fox TV, censoring and shaping its audience. But we live
in other times, not in the time of alienation, but of information. It's much harder
now, since the genie is out of the bottle, to try to fool everyone again. But,
YouTube tries by promoting kitten videos, and alienating content and censoring
content it considers controversial. Now who is above good and evil to judge
others? Hate speeches are one thing, but opinions are another. And, to what
measure does YouTube judge both? Robots mainly, which leads to error. And to
make matters worse, YouTube is investing 25 million dollars so that "reliable
sources" of "traditional" journalism can take better advantage of its platform, at
the same time fighting the so-called fake news. Whoa, traditional media is the
biggest maker of fake news, then expect more censorship and removal of
content.

YouTube, however, made an interesting gesture of goodwill to assist the small
channels: The paid subscription, where users have the option to contribute to the
channel they subscribe to. And as this "squeeze" in the small channels has been
around for some time, creators turn to crowdfunding platforms such as Patreon to
keep their earnings and continue with their channels.
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In fact, this new YouTube policy is very depressing, as many people have come
to earn their living from YouTube, taking their livelihood and their family’s income
from that service. I myself have become accustomed to seeing more of my news
channels on YouTube, than the traditional channels(TV's, newspapers, etc…).
And, all of this may be threatened now.

But, do not fear: there are other options. YouTube is not the only service of its
kind out there, and there are new services like D-Tube. D-Tube’s look is very
similar to YouTube, without the ideological restrictions. And Twitch TV is also
accumulating more and more content creators from the YouTube exodus.

So if YouTube does not care for and preserve its talented creators, it will end up
like traditional media: Just another cable TV channel with a lot of uninteresting
content, while its best assets (creators) will have migrated to other services.

In the future, I will write about alternatives to YouTube, which exist, and,
depending on what you want to do, in artistic terms and expression, can be much
better than YouTube.

Folks, everything I wrote in this series of articles, I tested in my You Tube
channel: https://www.youtube.com/channel/UC84De8g52Z0C5YzubnICzKg

So, if you are willing to see everything I wrote about in action, for real, take a look
at my channel, and if you feel inclined, subscribe to it.

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!
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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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as told to YouCanToo

What is your name/username?

Hello everyone, My name is `ĦξŘŤζ_.

How old are you?

I'm 50 years old.

Are you married, single?

I am single, I'm not married so far.

How about Kids, Grandkids (names and ages)?

No, I don't have any kids.

Do you have pets, what is your favorite?

No I don't have any pets for now, but I love all
animals, because for me they are incredible and
fantastic creatures of nature.

Are you retired, still working and if working, what
do you do?

No, I'm still working for the multinational brand and
most important in the world, my competences are
like security and administration service internal
systems.

Where do you call home? What is it like? IE:
weather, scenery

I'm from Italy. Now the weather in my country is
Spring, and the media temperatures are 20/21C
(68/69.8F). Today, for example, it is a sunny day.

Where did you go to school and what is your
education level?

I'm a self-taught. I don't have study in the college or
in the university. I have only the primary school
certificate.

What kind of things you like doing? hobbies,
travel, fishing, camping?

My hobbies are the computers, listen to music,
computer art, to draw, and many others.

Why and when did you start using Linux?

I started using Linux back in 1995 on my old, self
assembled PC.

What specific equipment do currently use with
PCLinuxOS?

I have installed PCLinuxOS on all my home
computers.

Do you feel that your use of Linux influences the
reactions you receive from your computer peers
or family? If so, how?

I can only say that Linux is most important for my
job, and in my private life every day as user and
local home administrator.

What would you like to see happen within
PCLinuxOS that would make it a better place.
What are your feelings?

For me, PCLinuxOS is just perfect.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

PCLinuxOS Family Member Spotlight: `ĦξŘŤζ_

http://www.pclinuxos.com/?page_id=10
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by Gennie Gebhart and Cory Doctorow for EFF
Reprinted via CC-SA-3.0 Creative Commons
License

With Gmail’s new design rolled out to more and
more users, many have had a chance to try out its
new “Confidential Mode.” While many of its features
sound promising, what “Confidential Mode” provides
isn’t confidentiality. At best, the new mode might
create expectations that it fails to meet around
security and privacy in Gmail. We fear that
Confidential Mode will make it less likely for users to
find and use other, more secure communication
alternatives. And at worst, Confidential Mode will
push users further into Google’s own walled garden
while giving them what we believe are misleading
assurances of privacy and security.

With its new Confidential Mode, Google purports to
allow you to restrict how the emails you send can be
viewed and shared: the recipient of your Confidential
Mode email will not be able to forward or print it. You
can also set an “expiration date” at which time the
email will be deleted from your recipient’s inbox, and
even require a text message code as an added layer
of security before the email can be viewed.

Unfortunately, each of these “security” features
comes with serious security problems for users.

DRM for Email

It’s important to note at the outset that because
Confidential Mode emails are not end-to-end
encrypted, Google can see the contents of your
messages and has the technical capability to store
them indefinitely, regardless of any “expiration date”

you set. In other words, Confidential Mode provides
zero confidentiality with regard to Google.

But despite its lack of end-to-end encryption, Google
promises that with Confidential Mode, you’ll be able
to send people unprintable, unforwardable,
uncopyable emails thanks to something called
“Information Rights Management” (IRM), a term
coined by Microsoft more than a decade ago.
(Microsoft also uses the term “Azure Information
Protection.”)

Here’s how IRM works: companies make a locked-
down version of a product that checks documents
for flags like “don’t allow printing” or “don’t allow
forwarding” and, if it finds these flags, the program
disables the corresponding features. To prevent
rivals from making their own interoperable products
that might simply ignore these restrictions, the
program encrypts the user’s documents, and hides

the decryption keys where users aren’t supposed to
be able to find them.

This is a very brittle sort of security: if you send
someone an email or a document that they can open
on their own computer, on their own premises,
nothing prevents that person from taking a
screenshot or a photo of their screen that can then
be forwarded, printed, or otherwise copied.

But that’s only the beginning of the problems with
Gmail’s new built-in IRM. Indeed, the security
properties of the system depend not on the tech, but
instead on a Clinton-era copyright statute. Under
Section 1201 of the 1998 Digital Millennium
Copyright Act (“DMCA 1201”), making a commercial
product that bypasses IRM is a potential felony,
carrying a five-year prison sentence and a $500,000
fine for a first offense. DMCA 1201 is so broad and
sloppily drafted that just revealing defects in Google
IRM could land you in court.

We think that “security” products shouldn’t have to
rely on the courts to enforce their supposed
guarantees, but rather on technologies such as end-
to-end encryption which provide actual mathematical
assurances of confidentiality. We believe that using
the term “Confidential Mode” for a feature that
doesn’t provide confidentiality as that term is
understood in infosec is misleading.

“Expiring” Messages

Similarly, we believe that Confidential Mode’s option
to set an “expiration date” for sensitive emails could
lead users to believe that their messages will
completely disappear or self-destruct after the date
they set. But the reality is more complicated. Also
sometimes called “ephemeral” or “disappearing”

Between You, Me, and Google: Problems
With Gmail's “Confidential Mode”
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messages, features like Confidential Mode’s
“expiring” messages are not a privacy panacea.
From a technical perspective, there are plenty of
ways to get around expiring messages: a recipient
could screenshot the message or take a picture of it
before it expires.

But Google’s implementation has a further flaw.
Contrary to what the “expiring” name might suggest,
these messages actually continue to hang around
long after their expiration date for instance, in your
Sent folder. This Google “feature” eliminates one of
the key security properties of ephemeral messaging:
an assurance that in the normal course of business,
an expired message will be irretrievable by either
party. Because messages sent with Confidential
Mode are still retrievable—by the sender and by
Google—after the “expiration date,” we think that
calling them expired is misleading.

Exposing Phone Numbers

If you choose the “SMS passcode” option, your
recipient will need a two-factor authentication-like
code to read your email. Google generates and texts
this code to your recipient, which means you might
need to tell Google your recipient’s phone
number—potentially without your recipient’s consent.

If Google doesn’t already have that information,
using the SMS passcode option effectively gives
Google a new way to link two pieces of potentially
identifying information: an email address and a
phone number.

This “privacy” feature can be harmful to users with a
need for private and secure communications, and
could lead to unpleasant surprises for recipients who
may not want their phone number exposed.

Not So Confidential

Ultimately, for the reasons we outlined above, in
EFF’s opinion calling this new Gmail mode
“confidential” is misleading. There is nothing
confidential about unencrypted email in general and
about Gmail’s new “Confidential Mode” in particular.

While the new mode might make sense in narrow
enterprise or company settings, it lacks the privacy
guarantees and features to be considered a reliable
secure communications option for most users.

Screenshot ShowcaseScreenshot Showcase

Posted by parnote, July 17, 2018, running Xfce.
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Editor’s Note: Tip Top Tips is a semi-monthly column in
The PCLinuxOS Magazine. Periodically, we will feature –
and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept
independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a
tip, share it in the PCLinuxOS forum’s “Tips & Tricks”
section. Your tip just may be selected for publication in
The PCLinuxOS Magazine.

This month’s tip comes from Agent Smith.

With the advent of HPLIP, HP's great program for
installing and managing printers of that brand, the
handling of these machines on Linux has become
very good, even better than on windows, since on
windows you always need the printer installation CD
, and if it does not exist, there goes the technician
search for drivers in the internet.

With HPLIP, the drivers are either integrated, or
downloaded over the internet.

But, it has a peculiarity: the proprietary plugin from
HP. This plugin is only installed by HPLIP. That is,
you must have HPLIP installed to be able to open a
terminal, invoke the hp-plugin, and install it.

However, often a new version of HPLIP has already
been released (and HPLIP only installs the current
version), or it is not possible to access the HP
website where the plugin is downloaded and the
installation does not advance.

And the tech folks go around kicking the printers and
cursing the mothers of HP company owners.

If this is your case, your problems are over. You can
now easily install the HP plugin without worrying
about the HPLIP version or downloading it from the
HP website.

Just go to this address:
http://www.openprinting.org/download/printdriver/
auxfiles/HP/plugins/

All versions of the HP plugin are archived on that
site, making it easier to access.

After downloading, in a terminal, give permission to
run and install the plugin without needing the
intervention of HPLIP.

That address saved my day, since I needed to install
an HP printer that needs this plugin and via HPLIP it
was not working.

I hope it helps you a lot.

Defending Your Rights

In The Digital World

Donate NOW

Linux Docs
Linux Man Pages

Tip Top Tips: Installing HP Printers
That Require The Proprietary Plugin
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http://www.openprinting.org/download/printdriver/auxfiles/HP/plugins/
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You can't keep Texstar

From ideas so fine

You can't keep him

From the divine

You can't keep his tries

From adoring eyes

You can't keep him

From success

Some things are always true

And so I'm telling you

You can't keep me

From loving PCLOS

You can't keep Texstar

From a plan so fine

You can't keep him

From a deadline

You can't keep his tries

He'll never compromise

You can't keep him

From success

Some things are always true

And so I'm telling you

You can't keep me

From loving PCLOS

You can't keep Texstar

From a great design

You can't keep him

From something fine

You can't keep his tries

From winning the prize

You can't keep him

From success

Some things are always true

And so I'm telling you

You can't keep me

From loving PCLOS

ms_meme's Nook: Midnight In The Forum

MP3 OGG

http://pclosmag.com/html/Issues/201808/files/midnightintheforum.mp3
http://pclosmag.com/html/Issues/201808/files/midnightintheforum.ogg
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INGREDIENTS

1 lb lean (at least 80%) ground beef
1 medium onion, chopped (1/2 cup)
2 cups milk
1 cup hot water
1 box Hamburger Helper™ cheeseburger macaroni
2 medium tomatoes, sliced
1 cup seasoned croutons
4 slices American cheese, cut in half diagonally

DIRECTIONS:

1. In 10-inch skillet, cook beef and onion over
medium-high heat 5 to 7 minutes, stirring frequently,
until beef is thoroughly cooked; drain.

2. Stir in milk, hot water, and uncooked pasta and
sauce mix (from Hamburger Helper box). Heat to
boiling, stirring occasionally. Reduce heat; cover and
simmer 10 minutes, stirring occasionally.

3. Arrange tomato slices on top; sprinkle with
croutons. Place 5 of the cheese halves around edge
of skillet; place remaining cheese halves in center.
Cover and cook 2 minutes. Remove from heat; let
stand covered 5 minutes (cheese will continue to
melt and sauce will thicken as it stands).

TIPS:

Serve on a bed of lettuce and top with guacamole or
your favorite burger toppings for the true California
cheeseburger experience.

PCLinuxOS Bonus Recipe Corner

California Cheeseburger Skillet

http://www.linuxfoundation.org/
http://www.fsf.org
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Posted by Meemaw, July 2, 2018, running Xfce.
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
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s

H
er

e

Possible score 261, average score 183.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201808/files/2018-08-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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August backpacking

baseball beach

bikini boating

camping canoeing

diving flowers

fresh fruit Frisbee

gardening hiking

humidity ice cream

lightning muggy

ocean outdoors

picnic popsicle

recreation sandals

sandcastle sailing

searing heat seashore

shorts sightseeing

summer solstice sundress

sunflower sunscreen

sweltering swimsuit

thunderstorm vacation

watermelon waterski

Download Puzzle Solutions Here

L P N W J S B K G K A O I T C H X F Q Y J G I Y F K G H P D
M J N D D B S G C Q E C H I L C C P N Y X X A V T N U N Y E
H E L V N Z M L C I N C I P J B Q E E Y I M W R I V O F H D
N S L A D N A S D A C M D D N T E Q H O H D U K D L W G G P
W J N F Z O Y L Q S W E L T E R I N G N I V I D E E N W O H
B I K I N I C E C R E A M Y B D V W M M O H G M O I N A W W
M O E A A T W T Y O B H W M V D I R W B E J R U N X G I V A
D H E E S A C O C J E C K A M P O Q A A Z E T T H X X H N I
O C Q M B E M R L Z G U K F R T Y S Q Y T D H C A M P I N G
O K J X T R P U R A Z A G S S L E G I A O G L O N O O Q H I
J C H B K C E O L D A N I R J B O N W O I P H E Y N W Q O H
B V C R S E W R L A I U E K A I Z B R L T B L S M V J K U E
F E L K J R H T H E U D A L K R L S T B Q T Q H U C U P H O
M W A W Z P E M E U N T L S E T N J V E S Z L S N A S U Y E
N N M B H B D S I U V T R M Q X Y M A A S T Y S J H M Y D R
Z W M O X T T Q H Q N E S Y I V J N C C G Q T X Z I X L A S
N N S A M H C T X K T Z S K X E L D A H Z H O Z D M M B F Z
G T U T G S J K E A N P E N A Q N W T V P J Z I D S H L F C
N A T I I S U L W W E S R Y I A F N I I T O T L B Y Z G L U
I E S N X W X N A X D C D J S O G T O E D Y P D K V E D O R
K H U G D Q M D F S C I N L A I P E N Z K X O K W B Q V W L
C G G K S O V D T L S D U W I W Y L L L F K P X C G Y Y E T
A N U U G K Q M B I O D S G L V Z S T R O H S G T C U D R H
P I A F M U N U P L U W T H I X H J H A D J I D M H W D S S
K R B O R J F G A Z F S E R N T Q H N M O D C G A L V O L R
C A N O E I N G Z Q D C M R G A P U W F F S L G Z H I B O V
A E F K R V S Y E B A P O I P K X M Z Z F R E S H F R U I T
B S T Q F B M B G Y P R M L W O F B N K V V K O W P Q C L M
W I S U N S C R E E N Z E T Y S U M M E R S O L S T I C E H
K W E C V V J W R E R O H S A E S N O W I Z K J M N D M P Z

PCLinuxOS Puzzled Partitions

PCLinuxOS Word Find: August 2018
Summer

http://pclosmag.com/html/Issues/201808/files/2018-08-PuzzleSolutions.pdf
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1. plastic disk one throws

2. looking at different scenery

3. first day of summer

4. bloom mostly in the summer

5. hot and humid

6. wear this at the beach

7. fun time off from work

8. rub this on to protect your skin

9. fun outside meal activity

10. tasty frozen dairy food

11. coastal place for water fun

12. fun to build at the beach

13. one indication a storm is coming

14. a hot summer month in the US

15. tasty summer fruit

16. popular sport in the summer

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Summer Crossword

http://pclosmag.com/html/Issues/201808/files/2018-08-PuzzleSolutions.pdf
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From the computer of ms_meme:
Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people. The magazine article
about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings. I have made a few
into cryptograms, and hope our readers will enjoy them.

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Cryptograms

http://pclosmag.com/html/Issues/201808/files/2018-08-PuzzleSolutions.pdf
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More Screenshot Showcase

Posted by Old-present_arms, July 1, 2018, running Trinity. Posted by sammy2fish, July 7, 2018, running KDE.

Posted by tuxlink, July 1, 2018, running KDE. Posted by OnlyHuman, July 7, 2018, running e23.




